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SPEEDING UP 

“WINDOWS XP” 

  

 

           

 

http://aztcs.org/
http://tmug.com/
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Web location for 

this presentation: 

http://aztcs.org 

Click on “Meeting Notes” 
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SUMMARY 
Using the "System" applet of the  

Windows “Control Panel” and 

services.msc which is a“Microsoft 

Management Console” Snap-in, 

you can dramatically increase the 

speed of any “Windows XP” 

computer, as perceived by the 

end-user. 
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BASIC STRATEGY 

• No direct editing of the “registry” 

• Make reversible changes to the 

"Windows.." operating system 

• Make “image backups” and 

“restore points”, prior to making 

changes 

• Take advantage of the 

compounding effects of multiple 

speedup tweaks 
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PROCEDURE & TOPICS  
• Step 1: Make an image backup of 

your "Windows" hard drive 

• Step 2: Create a “restore point” with 

Windows' "System Restore" 

• Step 3: Set “Visual Effects” for 

“..best performance” 

• Step 4: Supersize the swap file 

• Step 5: Run “Revo Uninstaller 

Freeware”  
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PROCEDURE & TOPICS (continued) 
• Step 6: Use "services.msc" to 

disable some services  

• Step 7: Perform “Error-checking” on 

all hard drives. 

• Step 8: Defragment the Windows 

swap file using Microsoft’s 

“PageDefrag”. 

• Step 9: Defragment all hard drives 

• Step 10: Turn off startup programs 

 

 

http://aztcs.org/meeting_notes/winhardsig/speedupWindows/startup_programs.pdf
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DETAILS OF STEP 1: 

Drive Image Backup 

• Use “Macrium Reflect Free 

Edition”, “Clonezilla”, or “Acronis 

True Image Home..”AND          

an external hard drive to create 

a "backup image" of the entire 

C: drive of your “Windows XP” 

computer. 

http://www.macrium.com/reflectfree.aspx
http://www.macrium.com/reflectfree.aspx
http://clonezilla.org/
http://ugr.com/TrueImage.html
http://ugr.com/TrueImage.html
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DETAILS OF STEP 1: 

Drive Image Backup 

• Our instructions for using the 

free and open source 

“Clonezilla” to make an image 

backup of a hard drive can be 

found at 

http://aztcs.org/meeting_notes/w

inhardsig/CZ-backup.pdf 

http://aztcs.org/meeting_notes/winhardsig/CZ-backup.pdf
http://aztcs.org/meeting_notes/winhardsig/CZ-backup.pdf
http://aztcs.org/meeting_notes/winhardsig/CZ-backup.pdf
http://aztcs.org/meeting_notes/winhardsig/CZ-backup.pdf
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DETAILS OF STEP 2: 

Create a “Restore Point” 

• Use Windows' “System Restore” 

to create a “restore point”: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2a: Click on the “Start” button which is 

located at the left or bottom of the gray 

"taskbar" in “Windows XP”: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2b: Click on “All Programs” in the “Start 

menu”: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2c: A pop-up sub-menu will be displayed: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2d:  Click on "Accessories": 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2e: A second pop-up submenu will be 

displayed: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2f: Click on "System Tools": 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2g: A third pop-up menu will be 

displayed: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 
• Step 2h: Click on "System Restore": 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2i: Select the "Create a restore point" 

option: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2j: Click on the "Next" button: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2k: Type in an appropriate description for 

the restore point: 



21 

DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2L: Click on the "Create" button: 
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DETAILS OF STEP 2: 

Create a “Restore Point” (continued) 

• Step 2m: Click on the "Close" button: 
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DETAILS OF STEP 3: 

Set “Visual Effects” for “Best Performance” 
• Step 3a: Double-click on “System” in the 

“Control Panel”. 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3b: A “System Properties” box will be 

displayed: 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3c: Click on the “Advanced” tab: 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3d: Click on the “Settings” button in the 

“Performance” section. 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 
• Step 3e: A "Performance Options" box will be 

displayed: 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 
• Step 3f: Select the “Adjust for best 

performance” option (in the "Visual Effects" 

tab): 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 
• Step 3g: Click on the “Apply” button of the of 

the “Performance Options” box (if the “Apply” 

button is not grayed out.) 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 
• Step 3h: Click on the “OK” button of the 

“Performance Options” box: 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3i: The "Performance 

Options" box will disappear. 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3j: Click on the “OK” button of 

the “System Properties” box: 
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DETAILS OF STEP 3: 

Set “Visual Effects”.. (continued) 

• Step 3k: The “System 

Properties” box will disappear. 
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DETAILS OF STEP 4: 

Supersize the Swap File 

• Step 4a: Double-click on “System” in the 

“Control Panel”. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 

• Step 4b: A“System Properties” box will 

be displayed: 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 

• Step 4c: Click on the “Advanced” tab of the 

“System Properties” box. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4d: Click on the “Settings” button in the 

“Performance” section. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4e: Click on the “Advanced” tab of the 

“Performance Options” box. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4f: Click on the “Change” button in the “Virtual 

Memory” section of the “Advanced” tab of the 

“Performance Options” box. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4g: A “Virtual Memory” box will be 

displayed: 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4h: Select the “Custom size” option of 

the “Virtual Memory” box. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4i: Change the number in the “Initial size 

(MB)” box to a much larger value but do not 

exceed the “Space Available” value that is 

displayed. (We suggest 100000..) 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4j: Change the number in the “Maximum 

size (MB)” box to the same number that you 

used in “Step 4j”. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4k: Click on “Set” button in the “Virtual 

Memory” box. 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4L: If a "System Properties" box states 

that you have to set the maximum page file 

size below 4096, click on its "OK" button and 

go immediately to Step 4t in “Appendix 1” 

(on page 100): 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4m: Click on the “OK” button of the 

“Virtual Memory” box to make it disappear: 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 

• Step 4n: If a "System Control Panel Applet" 

box states that you have to "..restart your 

computer.., click on its "OK" button to make 

this box disappear: 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4o: Click on the “OK” button of the 

“Performance Options” box to make it 

disappear: 
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DETAILS OF STEP 4: 

Supersize the Swap File (continued) 
• Step 4p: Click on the “OK” button of the 

“System Properties” box to make it disappear: 
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DETAILS OF STEP 4: 

Supersize the Swap File 

• Step 4q: If a “System Settings Change” box 

states that “You must restart your 

computer..”, click on its “Yes” button: 
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DETAILS OF STEP 4: 

Supersize the Swap File 

• Step 4r: After your computer 

reboots, use your Web  browser and 

other software application programs 

to see if your computer is 

significantly faster than prior to the 

performance of this procedure. 
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DETAILS OF STEP 4: 

Supersize the Swap File 

• Step 4s: If your computer is not signficantly 

faster, perform Step 4a through Step 4r, and 

try a larger minimum and maximum swap file 

size in "Step 4i" and "Step 4j". 



53 

DETAILS OF STEP 5: 

Run “Revo Uninstaller Freeware” 

• Run “Revo Uninstaller Free” to 

remove unwanted toolbars, 

updaters, and miscellaneous 

software programs. 

• See 

http://www.revouninstaller.com/revo

_uninstaller_free_download.html 

http://www.revouninstaller.com/revo_uninstaller_free_download.html
http://www.revouninstaller.com/revo_uninstaller_free_download.html
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DETAILS OF STEP 5: 

Run “Revo Uninstaller Freeware” 
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DETAILS OF STEP 6: 

Use “services.msc” to disable some services 
• Step 5a: Click on the “Start” button which is 

located at the left or bottom of the gray 

"taskbar" in “Windows XP”: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

• Step 5b: Click on “Run..” in the “Start menu”. 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 
• Step 5c: Inside the "Run" box, type 

services.msc 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

• Step 5d: Click on the "OK" button of the “Run 

box: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 
• Step 5e: A “Services” window will be 

displayed: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 
• Step 5f: Click on “Action” in the Menu bar 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

• Step 5g: Click on “Export List” in the pull-

down menu. 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 
• Step 5h: Use the "Export List.." box to save 

the “List Report” to a location in any hard 

drive, giving the report an appropriate name 

based on the time and date. 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

• Step 5i: Stop and disable “services” that 

you do not need. (Do not make any 

changes to "Volume Shadow Copy" 

service or the "Power" service). 

• Step 5j: For documentation on what you 

can stop and disable, see 

http://www.makeuseof.com/tag/winhack

-speed-up-your-computer-part-1/ 

 and 

 

http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.makeuseof.com/tag/winhack-speed-up-your-computer-part-1/
http://www.ss64.com/nt/syntax-services.html
http://www.ss64.com/nt/syntax-services.html
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

   and                      

http://www.techknowl.com/disable-

unwanted-services-and-speed-

up.html                                and  

http://www.techduke.com/2007/06/2

0/windows-services-background-

processes-explained/ 

   and 

 

http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techknowl.com/disable-unwanted-services-and-speed-up.html
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
http://www.techduke.com/2007/06/20/windows-services-background-processes-explained/
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 
   and                                       

http://www.ss64.com/nt/syntax-

services.html 

   and 

http://www.governmentsecurity.org/foru

m/index.php?showtopic=1480                                  

and 

http://www.blackviper.com/2008/05/19/bl

ack-vipers-windows-xp-x86-32-bit-

service-pack-3-service-configurations/ 

 

 

 

http://www.ss64.com/nt/syntax-services.html
http://www.ss64.com/nt/syntax-services.html
http://www.ss64.com/nt/syntax-services.html
http://www.ss64.com/nt/syntax-services.html
http://www.governmentsecurity.org/forum/index.php?showtopic=1480
http://www.governmentsecurity.org/forum/index.php?showtopic=1480
http://www.governmentsecurity.org/forum/index.php?showtopic=1480
http://www.governmentsecurity.org/forum/index.php?showtopic=1480
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
http://www.blackviper.com/2008/05/19/black-vipers-windows-xp-x86-32-bit-service-pack-3-service-configurations/
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

For example, to stop and disable the 

"Themes" service, do the following inside 

the "Services" box: 

Example Step 1: Locate the "Themes" 

service: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 2: Use your RIGHT mouse 

botton to click on the  "Themes" service: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 3: Click on "Properties" in 

the pop-up context menu: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 4: A "Themes Properties" 

box will be displayed: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 5: Click on the "Stop" button 

to stop the "Themes" service: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 6: Click on drop-down list 

button to the right of "Automatic":: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 7: A drop-down list will be 

displayed: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 8: Click on "Disabled" in the 

drop-down list: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 9: "Startup type" will now be 

shown as "Disabled": 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 10: Click on the "Apply" 

button: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

Example Step 11: Click on the "OK" button to 

make the "..Properties.." box disappear: 
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DETAILS OF STEP 6: 

Use “services.msc”.. (continued) 

• Extended view versus standard 

view of services.msc "Microsoft 

Management Console" snap-in 

o See 

http://www.winhelponline.com/bl

og/configure-services-mmc-to-

open-in-standard-view-by-

default/ 

 

http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
http://www.winhelponline.com/blog/configure-services-mmc-to-open-in-standard-view-by-default/
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DETAILS OF STEP 7: 

Error-checking on all hard drives 
• Step 7a: Click on the “Start” button which is 

located at the left or bottom of the gray task 

bar in “Windows XP”: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives 
• Step 7b: Click on "My Computer" in the 

"Start menu": 
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DETAILS OF STEP 7: 

Error-checking on all hard drives 
• Step 7c: A "Windows Explorer" window will 

be displayed: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7d: Use the RIGHT mouse button to 

click on the C: drive: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7e: Click on “Properties” on the pop-up 

context menu. 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7f: A "..Properties" box will be displayed: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7g: Click on the “Tools” tab of the 

"Properties" box:. 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7h: Click on the “Check now…” button. 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7i: Select the two options: 

• Step 7j: Click on the “Start” button. 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7k: Click on the “Yes” button: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7L: Reboot the computer. 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• Step 7m: A “chkdsk /f” will run during the 

startup of “Windows XP”: 
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DETAILS OF STEP 7: 

Error-checking on all hard drives (continued) 

• See 

http://support.microsoft.com/kb/

315265 

http://support.microsoft.com/kb/315265
http://support.microsoft.com/kb/315265
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DETAILS OF STEP 8: 

Defragment the Windows Swap File 

• Use Microsoft’s free 

“pagedefrag” software utility. 

o See 

http://technet.microsoft.com/e

n-us/sysinternals/bb897426 

o It only works for "Windows 

XP" and earlier versions of 

"Windows.." 

http://technet.microsoft.com/en-us/sysinternals/bb897426
http://technet.microsoft.com/en-us/sysinternals/bb897426
http://technet.microsoft.com/en-us/sysinternals/bb897426
http://technet.microsoft.com/en-us/sysinternals/bb897426
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DETAILS OF STEP 9: 

Defragment all hard drives 
• Step 9a: Click on the “Start” button which is 

located at the left or bottom of the gray task 

bar in “Windows XP”: 



93 

DETAILS OF STEP 9: 

Defragment all hard drives 

• Step 9b: Click on "My Computer" in the 

"Start menu": 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 
• Step 9c: Use the RIGHT mouse button to 

click on the C: drive: 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 

• Step 9d: Click on “Properties” on the pop-up 

utility menu. 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 

• Step 9e: Click on the “Tools” tab. 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 
• Step 9f: Click on the “Defragment Now..” 

button. 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 
• Step 9g: Click on the “Defragment" button of 

the "Disk Defragmenter" box: 
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DETAILS OF STEP 9: 

Defragment all hard drives (continued) 
• Step 9h: After the defragmentation for the C: 

drive completes, you should defragment any 

additional hard drives or hard drive partitions 

where you store data files:                                

Click on the listing of the drive; then click on 

the “Defragment" button.                               

Do NOT run the defragmentation process on 

hard drives or hard drive partitions that belong 

to the "Windows.." operating system such as 

those named "System", "System Reserved", 

"Dell Utilities", Factory Image", "Backup", etc. 
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APPENDIX 1 

Turning on "Physical Address 

Extension" ("PAE") 
• Step 4t: Perform “Step 4u" through "Step 

4zn", only if you were directed here from 

“Step 4L” on page 45. 

• The objective of these additional steps is 

to turn on "Physical Address Extension" 

which is also known as "PAE".  

• "PAE" is a Windows kernel extension. 

Some processors support it and some 

do not. 
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APPENDIX 1 

Turning on "PAE" (continued) 
• Step 4u: Double-click on "Folder 

Options" in the "Control Panel": 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4v: A "Folder Options" box will be 

displayed: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4w: Click on the "View" tab: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4x: Select the "Show hidden files 

and folders" option: 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4y: Remove the checkmark from 

"Hide protected system files. 

(Recommended)", if you find one there: 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4z: Click on the "Apply" button of 

the "Folder Options" box: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4za: Click on the "OK" button of the 

"Folder Options" box: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zb: The "Folder Options" box will 

disappear. 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zc: Start "Windows Explorer", "My 

Computer", or "Computer", and locate 

the "boot.ini" file. The "boot.ini" file is 

located in the root directory of the C: 

drive for all "Windows XP" computers. 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zd: Use "Notepad" or "Wordpad" 

to edit the boot.ini file by adding a          

/pae                                                                      

to it in the "[operating systems]" section: 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• In rare instances, you might encounter a 

processor chip that does not support 

"PAE" and your computer will only boot 

in "Safe Mode" with a press of the F8 

key during bootup. Once you get into 

"Safe Mode", you would then have to 

edit the "boot.ini" file to remove the 

/PAEthat you entered in earlier. 
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APPENDIX 1 

Turning on "PAE" (continued) 
• Step 4ze: Double-click on "Folder 

Options" in the "Control Panel": 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zf: A "Folder Options" box will be 

displayed: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zg: Click on the "View" tab: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zh: Select the "Do not show 

hidden files and folders" option: 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zi: Place a checkmark for "Hide 

protected system files. 

(Recommended)": 
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APPENDIX 1 

Turning on "PAE" (continued) 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zj: Click on the "Apply" button of 

the "Folder Options" box: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zk: Click on the "OK" button of the 

"Folder Options" box: 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zL: The "Folder Options" box will 

disappear. 
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APPENDIX 1 

Turning on "PAE" (continued) 

• Step 4zm: Reboot the computer. 

• Step 4zn: Go to “Step 4A” (on page 34). 
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APPENDIX 1 

Turning on "PAE" (continued) 

If you are running Windows XP inside an 

"Oracle VM VirtualBox" virtual 

machine:  

Prior to editing the "boot.ini" file, you will 

probably have to turn on "Enable 

PAE/NX" as follows:  
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APPENDIX 1 

Turning on "PAE" (continued) 

If you are running Windows XP inside an 

"Oracle VM VirtualBox" virtual 

machine (continued): 

Use the right mouse button to click on the 

"Windows XP" virtual machine in the 

"Oracle VM VirtualBox Manager" window.  

Select "Settings" from the pop-up context 

menu.  
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APPENDIX 1 

Turning on "PAE" (continued) 

If you are running Windows XP inside 

an "Oracle VM VirtualBox" virtual 

machine (continued): 

Click on the "System" selection of the 

"Settings" box.  

Click on the "Processor" tab.  
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APPENDIX 1 

Turning on "PAE" (continued) 

If you are running Windows XP inside an 

"Oracle VM VirtualBox" virtual 

machine (continued): 

Put a checkmark in the box to the left of 

"Enable PAE/NX", if there is not one 

already there.  

Click on the "OK" button of the "Settings" 

box.  
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APPENDIX 1 

Turning on "PAE" (continued) 


